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Overview
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Figure 1-1 Pocket SMI Interface in Pocket PC (left) and Titan (right)

If you are not familiar with SMI software on the HP 48, you may prefer the Pocket SMI
user interface, which offers the easy-to-learn organization of tabs and large buttons. There
is more room on the buttons to show the function name instead of the five-letter
abbreviation required for the Classic SMI keyboard overlay and soft keys. Many of the
commands started from the Pocket SMI interface actually run in the Classic SMI window.
Getting to any function is as easy as two taps — one to select the tab for the general
category of function and another tap to select the button to start the function. You may
also customize commands using the Pocket SMI Command Bar.

The Pocket SMI touch screen is divided into four different areas:
w the Title Bar

w the Command Bar

w the Command Tabs

w the Status Bar

Title Bar

At the top of the Pocket SMI display the Start icon, Classic SMI version, and the time are
shown. This area is called the Title Bar. Tapping on the Start icon or text brings up the
Start Menu.
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. Landscape oriented devices such as the Titan have a system bar at the bottom of the
screen instead of a title bar.

Pocket SMI 7.1 ¢ 12:36 €9

Figure 1-2 Title Bar
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Command Bar

At the top of the Pocket SMI interface is a row of ten buttons called the Command Bar.

FIZEEEEDE

Figure 1-3 Command Bar

ICON:

The first button is a calculator icon (above) that, when tapped, switches to the Classic
SMI interface.

The buttons labeled 1 through 8 can be assigned to any command. To change the
command assignments on the 1-8 buttons, tap on the Select a Command Bar Menu icon
(above). It opens the Select Command Bar Menu window. Tap on the Command Bar
menu you want to use and it will be immediately assigned to the Command Bar.

ICON:

The Customize button in the Select Command Bar Menu opens the Customize Command
Bar window. See Customize Command Keys/Customize Command Bar/Customize
Command Favorites on page 8 for more information.
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Command Tabs

The command tabs enable access to the major Pocket SMI commands. Tap on the tab to
see the buttons related to that tab.

Please refer the Version 7 User Guide and Pocket SMI Commands, which begins on
page 5, for more information about particular commands.

Job | Setup CDIIectlStakelCDgD

Setup GRS Raobot

Inst. POS Cmd Keys

Settings Skatus Crd Faw

Defaults | | GPS Opts || Re-Auth

Zero Geniddd

ZPFS Genid File

Figure 1-4 Command Tabs

Status Bar

The Status Bar shows the current job, the backsight point, the occupied point, the

foresight point or last point stored, and the soft input panel shortcut. Any of these settings
can be changed by tapping on the Status Bar.

[castierdocoa [ 1 [ 1 |Em|<]

Figure 1-5 Status Bar
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Most of the Pocket SMI commands are described in the SMI Version 7 User Guide.
Commands unique to Pocket SMI are described in this chapter in alphabetical order. All of
these commands are in the list of commands available when adding a command to a
command menu (see Customize Command Keys/Customize Command Bar/Customize
Command Favorites on page 8). Some of these commands are also in one of the tabbed
windows of the Pocket SMI interface. Each of the command descriptions starts with the
following entries: Product, Location, Command Group, and Abbreviation. When
applicable, the command icon is shown.

Command Description Format

Entry Definition

Product Products that include this command. Following are the programs that SMI offers:
w  SCE - Standard COGO

ACE - Advanced COGO

DCE - Data Collection

CVCE - Construction Five

DCER - Data Collection/Robotic

CVCR - Construction Five GPS/Robotic

w  DOT - Construction Five Department of Transportation

Fr99

Location The buttons to tap to get to the command. They are shown in the font that is
used on the device (usually Tahoma or Tahoma Bold).

Command Group The group in the Add Command window that the command is listed under. One
of the ways to see the Add Command window is to go to the Pocket SMI
interface and tap the Setup tab, tap on the Cmd Fav button, tap on the Select
button, tap on the Customize button, and in the Customize Command Favorites
dialog box, tap on the Add button.

Abbreviation The abbreviation for the command used on the Command Key menu on the
Titan.
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Classic SMI Settings

PRODUCT: SCE+

Classic SMI Location: File > Settings

Pocket SMI Location: Setup tab - Settings button
COMMAND GROUP: PROGRAM SETTINGS

ABBREVIATION: CSMIS

These actions open the Classic SMI Settings window. For more information, see the
Classic SMI Interface chapter in the SMI User Guide for your device.
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PRODUCT: SCE+
Classic SMI Location: Asterisk icon
Pocket SMI Location: Setup tab > Cmd Fav button

*

ICON:

COMMAND GROUP: PROGRAM SETTINGS
ABBREVIATION: FAV

Command Favorites

48 Boot height of Rod =
48 Note for Last Point
48 Note Prompt Toggle |
48 Next Number

48 Separate Dist. & Angle
48 Traverse

48 Store Remote Elevation
48 Angle Point for X Pt

48 Shoot X Pt

-

|Se|ect Menu | | Ok || Cancel |

Figure 2-1 Command Favorites Menu

The Command Favorites menu presents the current list of command favorites. Tapping on
a command immediately runs the command. Another way of running a command without

Chapter 2: Pocket SMI Commands 7



tapping on the screen is to use the up and down cursor keys to select the desired
command and then press the center of the Navigation button to run the command.

Tapping the button allows you to change the current menu of command

favorites to a different menu of commands. See Select Command Favorites Menu on
page 18 for more information.

Customize Command Keys/Customize
Command Bar/Customize Command Favorites

PRODUCT: SCE+
Classic SMI Location: File > Customize Command Keys

Pocket SMI Location: Setup tab > Cmd Keys button - Customize button OR
Select Command Bar Menu icon - Customize button OR
Setup tab > Cmd Fav button - Select Menu button >
Customize button

COMMAND GROUP: PROGRAM SETTINGS
ABBREVIATION: CMDKY, BARS, FAVS

The Customize Command window enables the creation and editing of menus of
commands that can be assigned to the Command Keys, Command Bar, or Command
Favorites. Changes are saved as they are made.

If you are modifying one of the menus that was installed with the program, tap the New
button while it is the current menu and give it a slightly different name. This will prevent the
menu from being replaced by the default version the next time the program is installed.

Customize Command Bar . Customize Command Favorites

Current Menu: Mew Current Menu:
|T0tal Skation Collect v| |My Commands
Commands: Commands:

Command Favorites
48 Sideshat 45 Job Functions Menu

45 Height of Rod - 45 Select Old Job
45 Setup Menu
43 In mnen eleck
o |

Figure 2-2 Customize Command Menus

Customize Command Menu Definitions

Current Menu This information indicates the menu that is currently being edited. Tap on
the triangle or press the up and down cursor keys while the current menu
is selected to change to a different menu.
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Customize Command Menu Definitions

New N Tap on this button to create a new command menu.
£
Delete Tap on this button to delete the current menu.
Delete
Add ndd Tap on this button to add a new command to the current menu.
For more information, see Add Command (below).
Remove Tap on this button to remove the current command from the list of 9
Remove commands. 2
0O
OK Tap on this button to accept the changes and close the Customize g :)
Command window. 3 "U
()
Up Arrow Tap on the Up Arrow to move the currently selected command up in the a g
Ll list of commands. “ ©
(%)
Down Arrow Tap on the Down Arrow to move the currently selected command down in §
+ the list of commands.
Add Command
Add Command
Command Group: -
48 Job Functions Menu H
48 Delete Menu -

Figure 2-3 Add Command Window

Command Group: The commands are divided into groups to make it easier to find the
command you are looking for. The current group is shown in the box. Tap on the
triangle or press the up and down cursor keys while the command group is selected to
change to a different command group.

Commands that start with 48 are the HP 48 commands. The other commands are unique
to Pocket SMI.

Chapter 2: Pocket SMI Commands 9



Download Geoid File

PRODUCT: GPS/ROBOTIC

Classic SMI Location: Geoid »> Download Geoid File
Pocket SMI Location: Setup tab > Geoid File button
COMMAND GROUP: GPS

ABBREVIATION: DLGEO

Select this command to start receiving a Geoid99 file from SMI Transfer 7. Select the To
DC menu item in SMI Transfer 7, click on the Send Geoid button, and select the Geoid file
to send.

Transfer Progress
Start Geoid Transfer on PC,
0%

Cancel

Figure 2-4 Geoid Transfer Screen
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Graphical Stakeout

PRODUCT: GPS/ROBOTIC
Classic SMI Location: Stake icon
Pocket SMI Location: Stake tab - Graphical button

Be

COMMAND GROUP: STAKE

ICON:

ABBREVIATION: GPSTK

3| Classic sM1 7.1 ¢ 12:33 €3
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Status: 0:1 RMS:12.992

Setup: 0°00'0D0"-1-8

I - (1,500 ft Rad at Center
Dist:  0.102 Cut: 0,133
South!| p.063 Grade: 2735.444
West: | p.og0 Elev: 2735577

Figure 2-5 Graphical Stakeout Screen

This screen is very useful for staking using GPS receivers or Robotic instruments. It can
also be used with conventional instruments. It assumes that the foresight point or station
has already been entered using in the Stake menu or in the CONST
menu. Graphical stakeout can also be used after tapping or in the
menu to stake the catch point or reference point.

The screen automatically updates every time a measurement is taken. For GPS receivers
that support it, the screen will be updated as fast as five times per second.

Graphical Stakeout Screen Definitions

Status This field displays information about communications with the instrument.
For GPS instruments, the Quality and Horizontal Error estimate values are
displayed in the status area.

Setup This field displays the backsight, occupied point, and foresight point.

Chapter 2: Pocket SMI Commands 11
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Graphical Stakeout Screen Definitions

Display

The display screen shows the point being staked and the location of the
rod. When staking with GPS, the top of the screen is north. With non-GPS
equipment, the top of the screen is toward the occupied point. The point
being staked is a plus icon. A prism is shown with a target icon and a GPS
receiver is shown as an antenna. The icons get larger when at the tightest
zoom. How tightly the display will zoom is controlled by the “Smallest length
of scalebar” setting in the Options window that is displayed when the
Options button is tapped. When the centers of the icons line up, a smiley
face is displayed to indicate that the shot is close enough to stake. How
close that is can also be changed in the Options window.

Options

Tapping the Options button displays the Graphical Stakeout Options dialog
box.

Graphical Stakeout Options
Close enough to stake: Ft.
Smallest length of scalebar: Ft.
Factor to increase scale by:

w Close enough to stake: The maximum distance between the
shot and point being staked required before the smiley face will
be displayed.

w Smallest length of scalebar: This distance limits how tightly the
display will zoom into the points. The scale bar is one-fourth the
width of the graphical display area. The icons get larger when at
the tightest zoom.

w  Factor to increase scale by: The scale to use when zooming to
fit the foresight point and the shot icon is determined by the
following formula: S * F * | where S is the smallest scale and F is
the factor to increase the scale and | is an integer larger than 1.

Scale Bar

The scale bar is one-fourth the width of the graphical display area.

Rod at Center
Toggle

This toggle switches between showing the rod in the center of the display
area and showing the foresight point in the center.

Text Output Area

Located at the bottom of the screen, this text is updated with each shot.

w  Dist: This is the distance between the foresight point and the
shot.

w  Cut/Fill: This is the distance between the grade elevation and
the shot elevation.

w  Grade: This is the elevation of the point being staked.

w  Elev: This is the elevation of the last shot taken.

Pocket SMI User Guide



Graphical Stakeout Screen Definitions

Come/Go - These buttons toggle between displaying Go/Come and Left/Right data and
Right/Left Comne: North/South and East/West data. When the orientation is switched, the
Right; graphical display changes as well, so the top of the screen is toward the
instrument or toward north, respectively.
North/South Morth: = Come/Go: This value is how far to go away from the instrument
East/West Fast: or come toward the instrument to get to the point.

w  Right/Left: This value is how far to go left or right. This figure
assumes the rodman's perspective is facing the instrument.

Close

@)

w  North/South: If using GPS, the Go/Come label is replaced with g
North/South. o ;%

w East/West: If using GPS, the Left/Right label is replaced with g :,
North/South. 3 "U
()

SO

2 x

Close Tapping on this button closes the graphical stakeout window. o
()

S

Instrument Status

PRODUCT: GPS/ROBOTIC

Pocket SMI Location: Setup tab - Status button
COMMAND GROUP: SETUP

ABBREVIATION: STAT

The Instrument Status command either brings up the GPS Status window or the Total
Station Status window, depending on whether a GPS receiver or a Total Station instrument
is in use.

Chapter 2: Pocket SMI Commands 13



Instrument Status (Total Station)

The Instrument Status window communicates with the current total station and displays
the status of the instrument about once every second. This is most useful with robotic
instruments.

Instrument Status

HA Circle: 120°31°'41"
Zenith Angle: 85°21'31"
Slope Distance: 1179.481
Track Status: STANDBY

Inst. Battery:
Figure 2-6 Instrument Status Dialog Box

Instrument Status Dialog Box Definitions

HA Circle This is the current horizontal circle reading on the instrument.

Zenith Angle This is the current zenith angle reading on the instrument.

Slope Distance This is the current slope distance reading on the instrument.

Track Status This indicates whether the instrument is tracking the prism.

Inst. Battery This shows the current battery charge level.

14 Pocket SMI User Guide



Instrument Status (GPS Receiver)

The GPS Status Window communicates with the current GPS receiver and displays the
status of the receiver.

& ||:|assic5M17.1 ¢ 12:33 €3

— Position Quality

Solution Type: Qi1 Autonomous Solution
H. Error: 0,750 meters HDOP: 1,800
W, Error: 1,290 meters WDOP: 3,400
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S inview: 7
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Radio Latency: 0,000 secs
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Figure 2-7 GPS Status Window
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GPS Status Window Definitions

Solution Type Possible values arranged from worst to best are:
= No Solution: Not enough satellites to calculate position.

=  Autonomous Solution: Position calculated without
corrections.

= Augmented Solution: Positions calculated with corrections.
This could be differential or WAAS corrections.

w RTK Float Solution: Positions calculated with corrections from
a base station, but the satellite arrangement or radio signal is
too poor for an exact solution.

= RTK Fixed Solution: Positions calculated with corrections from
a base station.

H. Error This is the horizontal error estimate reported by the receiver.

V. Error This is the vertical error estimate reported by the receiver.

HDOP This is the horizontal dilution of precision. This number should be below 2
for good results. Poor satellite arrangement will cause this number to be
high.

VDOP This is the vertical dilution of precision. This number should be below 3 for

good results. Poor satellite arrangement will cause this number to be high.

Sky View This shows the arrangement of satellites in the sky. North is toward the top
of the screen. Satellites with four small lines outside their circle are just
being tracked. Satellites with eight small lines outside their circle are in
dual frequency mode and are above the elevation mask.

Chapter 2: Pocket SMI Commands 15



GPS Status Window Definitions

SV in sky This is the number of satellites in the sky according to the almanac.
SV in view This is the number of satellites being tracked.
SVin use This is the number of satellites being used in the position calculations.

Radio Latency

This is the number of seconds that have passed since the last correction
was received. If the receiver can receive corrections from WAAS satellites,
the radio latency will show the latency as 3-7 seconds. If it is receiving

radio signals from a base station, the latency should be 1 second or less.

Elev. Mask This is the number of degrees above the horizon a satellite must be before
being used in the solution calculation. Ignoring satellites below the
elevation mask helps reduce error introduced by atmospheric
interference.

Close This button closes the GPS Status window.

Close

Next Button

16

PRODUCT: SCE+

Classic SMI Location: Next button

IcoN:

COMMAND GROUP: PROGRAM SETTINGS

ABBREVIATION: NEXT

Tapping the button simulates tapping the button in Classic SMI, which
switches the Classic SMI soft key menu to the next page of soft key options.
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Select Command Bar Menu

PRODUCT: SCE+
Pocket SMI Location: Command Bar Properties icon

ICON:
COMMAND GROUP: PROGRAM SETTINGS o
>
ABBREVIATION: BAR %
0O
o =
SN
3y
my menu SO
QX
@
(%)
s

Figure 2-8 Select a Command Bar Menu

The Select Command Bar menu presents a list of command bar menus from which to
choose. As soon as a menu is selected, the commands defined in the selected menu are
displayed and assigned to the command bar.

Tapping the Customize button allows you to create and edit command bar menus. See
Customize Command Keys/Customize Command Bar/Customize Command Favorites on
page 8 for more information.

Chapter 2: Pocket SMI Commands 17



Select Command Favorites Menu

18

PRODUCT: SCE+

Pocket SMI Location: Setup tab - Cmd Fav button - Select Menu button
COMMAND GROUP: PROGRAM SETTINGS

ABBREVIATION: FAV

Customize Close

Figure 2-9 Select Command Favorites Menu

The Select Command Favorites Menu window presents a list of Command Favorites
menus. Tapping on a menu name immediately selects the menu and shows the Command
Favorites window with that menu active. A menu can also be selected by using the up and
down cursor keys to select the desired menu and then pressing the center of the
Navigation button to activate the menu.

Tapping the Customize button allows you to change the current list of command favorites.
See Customize Command Keys/Customize Command Bar/Customize Command
Favorites on page 8 for more information.
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Select Command Keys Menu

PRODUCT: SCE+
Classic SMI Location: Button icon
Pocket SMI Location: Setup tab > Cmd Keys button

-*

ICON:

COMMAND GROUP: PROGRAM SETTINGS
ABBREVIATION: FMENU

Select Command Keys Menu

Total Station Collect

Realtime Stakeout

Figure 2-10 Select Command Keys Menu

Tapping on the button icon in Classic SMI opens the Select Command Keys Menu
window, which enables you to assign a predefined list of commands to the four small hard
keys below the screen.

Tapping the Customize button allows you to change the current list of command keys. See
Customize Command Keys/Customize Command Bar/Customize Command Favorites on
page 8 for more information.

On the Titan, there are five hard keys (F1, F2, F3, F4 and Tab) below the screen. An
abbreviation of the command names appears on the screen above the hard keys.

Chapter 2: Pocket SMI Commands 19

spuewwon

Q
>
Q
©
=
®
=
N
T
o
Q
=
@
=
(%2)
S




Soft Key Commands

PRODUCT: SCE+

Classic SMI Location: File > Customize Command Keys > Add
Pocket SMI Location: Setup tab > Cmd Keys button - Add button
COMMAND GROUP: PROGRAM SETTINGS

ABBREVIATION: SOFT1, SOFT2, SOFT3, SOFT4, SOFT5, SOFT6

The Program Settings group in the Add Command window contains six commands for
Classic SMI soft keys one through six. They are named “48 Softkey 1" through “48
Softkey 6". Each command simulates tapping the corresponding soft key in the soft key
menu. The soft key commands are most useful when assigned to command keys.

Add Command
Cammand Graup: ‘ragram Settings

43 Softkey 1 -
45 Softkey 2 |
43 Softkey 3

43 Softkey 4 L
43 Softkey 5 E
43 Softkey & |
48 Next Key &

Figure 2-11 Add Command - Program Settings Menu

Switch Classic & Pocket

PRODUCT: SCE+
Classic SMI Location: Calculator icon
Pocket SMI Location: Calculator icon

ICON:

COMMAND GROUP: PROGRAM SETTINGS
ABBREVIATION: SWTCH

The Switch Classic & Pocket command switches the current user interface between
Classic SMI and Pocket SMI.
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Use Geoid99

PRODUCT: GPS/ROBOTIC

Classic SMI Location: Geoid > Use Geoid99
Pocket SMI Location: Setup tab > Geoid99 button
COMMAND GROUP: GPS

ABBREVIATION: GEOID

£ Classic SMI 7.1 ¢ 12:33 €3
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JOB | sIDS [SETUP| SC | TRAV | HEXT
COMNST| RPTS | CUST |PAUSE| STAKE|ROBOT|
~~ | == | PRINT | VIEW | CHG | P-P
+.-— [MORE| DEL | 4um
aPHa| 7 ] 8 | 9 =

v Use Geoid99
CAH Download Geoid File pC +

File|Geoid|Help e I EE

Figure 2-12 Geoid Menu

Select this command to correct GPS heights reported by GPS receivers using Geoid99
files. The option is on when a check mark appears next to the menu item in the Classic
SMI menu.
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EXERCISES

These lessons are written so that they can be followed
regardless of the type of device you are using (Pocket
PC, Titan, Allegro, etc.).

Note to Pocket PC Users: Note that when the lesson
refers to using up, down, left, and right arrow keys or the
ENTER key, you should use the Navigation button at the
bottom of the screen. Press the sides of the Navigation
button for arrow keys and the center to run the currently
selected button. When popup windows are in front of the
Pocket SMl interface, the center of the Navigation button
simulates the ENTER key.

In this chapter:

Configure the Command Keys ... ............... 24
Select a Command Favorites Menu . . ............ 25
Use a Command FavoritesMenu . ... ............ 27

CHAPTER

Chapter 3: Exercises 23



Configure the Command Keys

In this example, we will select a Command Key menu, which is a predefined group of
commands to be assigned to the physical keys directly below the screen. The SMI
Command Key assignments are only active while SMI is running. The name of the
Command Key menu that we will assign in this example is "Command Favorites" because
it contains shortcuts to the Command Favorites commands.

QuickSteps

24

1.

Pocket PC:

Select START - Classic SMI, or press the voice record button on the side of the
unit to start SMI. If you are already running SMI and you are viewing the Pocket
SMi interface, tap the Switch User Interface icon to display the Classic SMI
interface.

Non-Pocket PC:

Tap the Calculator icon.

Pocket PC:

Tap the Select Command Keys Menu icon on the status bar.
Non-Pocket PC:

Tap the Properties icon in the lower right corner of the screen.

This will display the Select Command Keys Menu dialog box.

Customize Close

Figure 3-1 Select Command Keys Menu Dialog Box

3. Screen:

Since we are going to select a predefined menu, tap on the Command Favorites
menu.

Keyboard:

Use the up and down arrow keys to select Command Favorites and press
ENTER.

Pocket SMI User Guide



This displays the Current Commands dialog box.

Current Commands @

Current Cornrnands:

1: Cornrnand Favorites

2 Select Cornmand Fav,
30 48 Mext Key

4: Switch Classic & Pocket

Figure 3-2 Current Commands Dialog Box

4. Tap OK or press the ENTER key to close the Current Commands window.

The current commands that are now mapped to the four buttons, or keys, below the
screen should be as they are listed in this dialog box.

These commands allow you run some of the most common commands without the need
to tap an icon or button on the screen to run the desired command.

Menus of commands can be created for both the Command Keys and Command
Favorites, so you can switch to a new set of commands with just a couple of key presses.
For more information about these features, refer to Customize Command Keys/Customize
Command Bar/Customize Command Favorites on page 8.

Select a Command Favorites Menu

In this example, you will become familiar with selecting a Command Favorites menu. The
Select Command Favorites Menu window can be started by pressing the Select Menu
button in the Command Favorites window, but this example will demonstrate how to do it
while avoiding using the touch screen.
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QuickSteps

1. Make sure that the Command Favorites menu is assigned to the command keys
as shown in Configure the Command Keys on page 24.

2. Press the second command key from the left, which is assigned to the Select
Command Favorites menu.
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Robotic Collect
Robotic Setup

This will display the Select Command Favorites Menu.

Customize Close

Figure 3-3 Select Command Favorites Menu

3.

Use the up and down arrow keys to select the Job Setup menu and press the
ENTER key.

This will automatically display the commands configured for this menu.

Use the up and down arrow keys to select the 48 New Job command.
Non-Pocket PC:

The JOB command is printed on the overlay for quicker access. The Command
Favorites command is more useful for commands that are not on the overlay.

This will display the Create New Job screen.

REATE NEH JOE

1
SHAE, BAGE
aHAH, BAGEA

168, aBaE

EL |MOTE | NEW

Figure 3-4 Create New Job Screen

5.

Tap on the New soft key located in the lower right portion of the screen.
Pocket PC:

An alternate method is to use the Navigation button to highlight the New soft
key and press the center of the Navigation button to activate the New soft key.

The screen will display the prompt:
NEW JOB?

Type the word BOUNDARY .

Pocket PC:

Use the Classic SMI keyboard or the soft input panel options. For more
information on these methods, see the Entering Characters section in the
Getting Started chapter of the SMI for Pocket PC User Guide.

Non-Pocket PC:

Use the physical keyboard.

Tap the ENTER key to create the job BOUNDARY.

Pocket SMI User Guide



This will display the SETUP screen with the job name showing in the upper left corner.

CVCR Ml
EQUNDARY: CRO

SETUP
A"a0 ' Ba" a1l MM 2

Figure 3-5 Setup Screen

Use a Command Favorites Menu

In this example, you will become familiar with using a Command Favorites menu after it
has already been selected as the current menu.

QuickSteps
1. Make sure that you have completed the steps in Configure the Command Keys
on page 24 and Select a Command Favorites Menu on page 25.

2. Press the first command key, which is the first button from the left below the
screen.

You can select any command from the list by tapping the screen to run the command
or by using the arrow keys and ENTER key.
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Command Favorites

48 Job Functions Menu -

48 Occupied Point

48 New Job

48 Delete Job

48 Slope Stake

48 Job Functions Menu

48 Foresight Station

48 Clear Instrument Mode

48 Stake Menu ||
42 Ctala tn ol ina T

|Se|ect Menul | Ok || Cancel |

File Geoid Help @ v 3 B E|~

Figure 3-6 Command Favorites — Job Setup Menu

3. Tap or use the arrow keys and ENTER to run the 48 Occupied Point command.
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. If you press and hold the arrow key, the highlight bar will move quickly down the list of
commands.

The screen will display the prompt:
OCCUPIED POINT?

CVCR iMl FRG
EQUNDARY: CRO

OCCURIED POIMT?

Figure 3-7 Occupied Point Prompt

4. Type the number 1.

Tap the ENTER key to accept the value.

Run the Command Favorites command like you did in step 2.
Tap the 48 Height of Rod command.

The screen will display the prompt:

HEIGHT ROD?

N o o

CVCR i3 iMl FRG
EQUNDARY: CRO

HEIGHT ROD?

Figure 3-8 Height of Rod Prompt

8. Type 5 and press the ENTER key to accept the value.
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